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Overview of this manual
About this manual

This manual contains information and instructions for installing, configuring,
programming, and running Painting PowerPac.

Usage
This manual should be used during installation and configuration of Painting
PowerPac. It describes Painting PowerPac and includes step-by-step instructions
to perform the tasks.

Who should read this manual?
This manual is intended for:

• System integrators
• End Customers
• Offline Programmers
• Robot Paint and service technicians
• ABB engineers

Prerequisites
The reader should:

• Have experience with RobotStudio
• Have experience of installation and configuration work
• Good skills in the IRC5 robot controller and RAPID programming

References

Document IDReferences

3HAC032104-001Operating manual - RobotStudio

3HAC020738-001Operating manual - Troubleshooting IRC5

3HAC050917-001Technical reference manual - RAPID Instructions, Functions and
Data types

Document.ID-1Technical reference manual - RAPID overview

3HAC050946-001Technical reference manual - RAPID kernel

3HAC050948-1Technical reference manual - System parameters

3HNA025117-001Operating manual, IRC5P RW6.0

Other references

DescriptionReferences

RobotStudio Support Forumhttp://www.robotstudio.com/forum/

Continues on next page
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Revisions

DescriptionRevision

First revision.-

Updated for 6.04 release. Rearranged the chapters andmost sections
are updated.

A

Updated for 6.06 release.B
Following are the updates:

• Updated the section Licensing on page 19.
• Updated the section Manage Workpiece on page 56.
• Updated the section Distribution rules on page 90.

Updated for 6.06 SP1 release.C
Following is the update:

• Updated the section Generating a report on page 82.

Updated for 6.07 release.D
Following are the updates:

• Updated the section Manage brush parameters on page 54.
• Added the section Manual Paint Stroke on page 47.
• Added the section Modify JointTarget on page 37.

Updated for 6.08 release.E
Following are the updates:

• Updated the section Graphical user interface on page 13.
• Updated the section Conveyor tracking on page 78.
• Updated the section Target reachability on page 41.

Updated the references. Added the Operating manual, IRC5P RW6.0
– 3HNA025117-001.

F

Updated for RobotStudio 2019.1 release.G
Following are the updates:

• Added the section Verify the robot motion on page 43.
• Updated the section Manual Paint Stroke on page 47.

Updated for RobotStudio 2019.3 release.H
Following is the update:

• Updated the section Semi automatic path generation on
page 44.

• Updated the section Identify panels on page 59
• Updated the section Creating a Spray Fan table on page 74
• Deleted the section Editing a Spray Fan table.

Updated for RobotStudio 2020.2 release.J
Created new section: PaintStroke Node on page 49
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Safety
Safety of personnel

A robot is heavy and extremely powerful regardless of its speed. A pause or long
stop in movement can be followed by a fast hazardousmovement. Even if a pattern
of movement is predicted, a change in operation can be triggered by an external
signal resulting in an unexpected movement.
Therefore, it is important that all safety regulations are followed when entering
safeguarded space.

Safety regulations
Before beginning work with the robot, make sure you are familiar with the safety
regulations described in the manual Safety manual for robot - Manipulator and
IRC5 or OmniCore controller.
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1 Introduction
1.1 About Painting PowerPac

Overview
The Painting PowerPac is an add-in of RobotStudio which is used to edit the paint
programs. It provides functions to connect, fetch and transfer files to the robots
on the shop floor. This enables the software to be used as a tool on the shop floor
to edit the programs without disturbing the ongoing production.
Use Painting PowerPac for controlling a range of features, such as:

• Fetching paint programs from the robots on the shop floor into RobotStudio
• Editing of Paint path
• Verify target position reachability and trigger events
• Setting and editing of trigger events
• Simulating paint programs
• Transferring files to robots
• Enabling user login based access to features
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1.2 Terms and concepts of Painting PowerPac

Terms and concepts
The following table lists the terminologies and concepts used in Painting PowerPac.

DescriptionConcept

Virtual controllers can run both the systems for real robots and spe-
cific virtual systems for testing and evaluation purposes. A Virtual
Controller uses the same software as the controller to execute the
RAPID program, to calculate robot motions and to handle I/O signals.

Virtual Controller

IRC5 Paint Controller.Real Controller

The CADmodel on which the paint programs are created are referred
to as Workpiece. In a RobotStudio station, there can be several CAD
models, some represent the part being worked upon and others the
environment.

Workpiece

Unique segments of a workpiece can be grouped together and identi-
fied as a Panel. For example, Door, Hood, and so on. Panels are used
while generating the paint path.

Panel
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1.3 Graphical user interface

Painting tab
Following is the graphical user interface of Painting PowerPac.

xx1600001474

DescriptionComponentLabel

Contains the features required to modify and
verify paint programs.

Painting ribbon1

Displays the components of the station in a
tree structure.

Programming window2

3D display of the painting application. You
can directly select fromGraphics window and
edit the station objects.

Graphical window3

Displays the log of the user actions while
using Painting PowerPac.

Output4

Painting ribbon

xx1600001475

The Painting ribbon consists of the following groups and buttons:

DescriptionButtonGroup

Allows you manage the programs.ManageProgram

Loads modules and workpiece associated
with a program into RobotStudio station.

Load

Saves the changes to a program.Save

Distribute files to different controllers.Transfer

Allows you to edit instruction and target
properties.

PropertiesModify

Continues on next page
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DescriptionButtonGroup

Displays the available programs. Select a
program from this list for the simulation.

Program listSimulation
Control

Allows you to specify the objects on the
production line to be processed.

Job Queue

Allows you to configure several initial states
which are used in sequence during a simula-
tion.

Batch

Allows you to configure and stage a simula-
tion.

Simulation Setup

Allows you to manage the simulation of the
selected program.

Simulation Control buttons

Allows you to configure signal, group, and
cross connections during programexecution.

I/O Simulator icon

Allows you to visually detect the critical robot
movements during simulation.

TCP Trace icon

Allows you to jog the conveyor.JogConveyor

Resets the conveyor to the start position.Reset

Detaches the workobjects, clears the placed
objects, and resets the conveyor to the start
position.

Clear

Allows you tomanage the brush parameters.Brush TablesEditor

Enables the report functionality.EnabledReports

Opens the latest available report from the
history.

Analyze

Displays all the available reports.History

Allows you to to manage the movement of
the robot using freehand tools, manage the
view of the robot system, and select the co-
ordinate system.

Free hand toolsFreehand

Allows you to define the parameters used
for generating paint path.

Path ParametersSettings

Allows you to configure the connection
between virtual and online controller.

Map to Online Controller

Allows you to configure the distribution rules.Distribution Rule

Allows you to configure the users and groups
with its associated features.

Users and Groups

Allows you to display or hide graphical
components in the graphical window.

Show HideGraphics

Continues on next page
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Programming window

xx1500002637

DescriptionComponent

Lists the robots and displays their connection status to the mapped
real robot.

Robots

Lists all the loaded program targets for the selected Controller. The
short cut to toggle and the paths are displayed in the target mode.

Targets

Lists all the instructions in the loaded programs for the selected
Controller.

Instructions

Graphical window
The graphical window displays the station contents. Following are some of the
paint specific features of the graphical window:

• The path is shown in 3D.
• The SetBrush instructions are represented graphically.

Continues on next page
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• The path segment is colored based on the SetBrush number. Depending on
the position of SetBrush on the path segment its visualization is displayed
in white, red, or yellow.

- White indicates a proper positioning of the SetBrush.
- Red indicates the trigger plane is outside subsequent path segments.
- Yellow indicates the trig plane is inside the zone.

xx1500002636

DescriptionComponent

Allows you to control which objects can be selected in the
graphical window.

Selection Level

Allows you to control how the selection point is snapped to
geometric features.

Snap Mode

Allows you to select the measuring tools.Measuring Tools
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2 Installation
2.1 System requirements

Overview
For details about the system requirements, see Operating manual - RobotStudio.
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2.2 Installation

Installing Painting PowerPac
1 Double-click on the Painting PowerPac.exe installation file.

This is a self-extracting executable. When you double-click it extracts all the
installation components to a specified folder.

2 Navigate to the extracted location.
3 Click setup.exe.

Follow the instructions in the installation wizard and finish the installation.
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2.3 Licensing

Overview
The Painting PowerPac software licenses are designed to provide attractive and
cost effective solutions to cater to the Engineering (Office) and Operations (shop
floor) requirements.
The following licensing options are available:
Licenses for PC software

• RobotStudio
- Basic
- Premium

• Painting PowerPac
- Basic
- Premium

License on Robot controller
• ShopFloor PPP Enabler PaintWare option.

Operating manual - RobotStudio
For details about RobotStudio licensing, see Operating manual - RobotStudio.

DescriptionLicense type

This is a PaintWare option which enables the transfer of files
between real controller and Painting PowerPac.

ShopFloor PPP Enabler

This option is available with PaintWare 5.15.14 and 6.05 on-
wards.

In Basic (or No license) version of RobotStudio, the functions
relevant to visualizing and simulating path programs are
available. The changes to the station cannot be saved.

RobotStudio Basic

Provides access to all RobotStudio features.RobotStudio Premium

Similar to the RobotStudio Basic version, the Basic (or No li-
cense) version of PowerPac enables functions relevant to
visualizing and simulating path programs.

Painting PowerPac Basic

Provides access to all the features of Painting PowerPac. This
requires RobotStudio Premium license.

Painting PowerPac Premi-
um

The licensing options can be selected (not restricted) based on the project
requirements.
Engineering requirements

DetailsLicense TypeRequirements

License/ user (PC)Requires Premium licenses of
both the products (RobotStudio
and Painting PowerPac).

Note

The ShopFloor PPP Enabler
option is not required on the
Robot Controller if the PC soft-
ware has Premium licenses.

Typically software is executing
on a office PC for creating sta-
tions, path programs, test vari-
ous simulation scenarios, in-
cluding commissioning tasks.
You need full access to all the
functions in RobotStudio and
Painting PowerPac including
connect, load, edit, and transfer
files with the robot controller.

Time bound license

Continues on next page
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Operations requirements

DetailsLicense TypeRequirements

License/robot controller.Requires the ShopFloor PPP
Enabler option on robot control-
ler.

Typically software is executing
on a shop floor HMI/PC on the
paint line.

License is perpetual as it
is a robot controller licence

License is not required for the
PC software. The basic mode
of RobotStudio and Painting
PowerPac is sufficient for
shopfloor operations.

Note

The License keys of the virtual
and real controller must match
to enable the file transfer
between Painting PowerPac
and Paint robot.

You need access to functions
necessary to connect, load,
edit, and transfer files with the
paint controller.
License should not expire for
shop floor software.

Relevant shop floor func-
tions are enabled in the
basic mode with the Paint-
Ware option.

ShopFloor PPP enabler
If you have a valid license for the ShopFloor PPP Enabler option, the option to
enable this feature is available to you when you create a system using Installation
Manager as shown in the following figure.

xx1700000925
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2.4 Start Painting PowerPac

Starting Painting PowerPac
To start the Painting PowerPac:

1 Create a new paint station, or open an existing paint station by using
RobotStudio.

2 Click the Add-Ins tab and click Painting in the PowerPacs group.

xx1500002630

The Painting PowerPac is started.
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3 Workflow
3.1 Overview

Workflow overview
Painting PowerPac is a programming tool used on the paint lines for optimizing
existing programs or in the office for creating programs for new models. The
following steps indicate the workflow to work with paint program using RobotStudio
and Painting PowerPac:

1 Prepare RobotStudio Station.
2 Prepare Workpiece.
3 Prepare Programs.
4 Simulate the paint cell.
5 Reports and analysis.
6 Deploy stations to shop floor.
7 Edit paint programs on the shop floor.
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3.2 Prepare RobotStudio stations

Preparing RobotStudio stations
A RobotStudio station consists of one or more robots, conveyors and peripheral
equipment. The station must match the real paint cells closely.
Refer to RobotStudio manual for more information on preparing stations and
configuring conveyors.

24 Operating manual - Painting PowerPac
3HAC054618-001 Revision: J

© Copyright 2020 ABB. All rights reserved.

3 Workflow
3.2 Prepare RobotStudio stations



3.3 Prepare workpiece

Preparing workpiece
You can use the following steps to prepare the CAD model of the object that must
be painted. The object CAD model is referred as workpiece.

1 Import the CAD model into a RobotStudio station.
2 Reduce the data in the CAD model, see Manage Workpiece on page 56.
3 Prepare Panels for painting, see Identify panels on page 59.
4 Position the workpiece in the paint cell to prepare for programming.
5 Create WorkObjects on the workpiece.
6 Identify Collision sets.
7 Save the workpiece as [$Workpiece name].rslib.

Note

To prepare the CAD model for interior painting, you need to identify the details
of the links and joints in the workpiece and create mechanisms to simulate the
joint behavior. For example, opening door, hood, trunk.
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3.4 Prepare programs

Preparing programs
Use the following steps to create paint paths on the workpiece.

1 Create program structure, see Manage programs on page 31.
a Create a new program from existing or blank program.
b Assign a Program number and Name.
c Create new modules or associate existing modules with the program.
d Associate Workpiece library and WorkObjects with the program.

2 Load program to RobotStudio, see Load program on page 34.
3 Create paint paths and instructions, see Edit paint programs on page 36.

• Generate paths automatically, see Semi automatic path generation on
page 44.

4 Define Brush tables, see Manage brush parameters on page 54.
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3.5 Simulate the paint cell

Simulating the paint cell
Use simulation to confirm the execution of programs on the paint controller.
Programs can be tuned for speed, efficiency and cycle time.

1 Simulate paint programs, see Simulation on page 65.
2 Simulate various scenarios, see Batch simulation on page 70.
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3.6 Reports and analysis

Reporting and analysis
The estimated paint consumption and simulation results are available after
simulation, see Reporting functions on page 81.
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3.7 Deploy stations

Deploying stations to the shop floor
When the program is ready to be tested on the paint line, you can prepare your
station for shop floor operations. The shop floor PC settings and their details are
listed in the following table.

DetailsSettings
• Install RobotStudio and Painting PowerPac on the shop floor PC.
• Unpack the RobotStudio station on the shop floor PC.
• Activate the Painting Powerpac add-in.

Note

To automatically load the Painting PowerPac add-in while starting
RobotStudio, you must enable the Activate on startup option.
This option is available in the Add-Ins tab, underAdd-Ins browser
> PowerPacs > Painting > Activate on startup.

General

Map Virtual and Real robots, see Manage connections on page 87.Connections
• Ensure that Programs have correspondingWorkObjectsmapped,

see Manage programs on page 31.
• Check the option Update WorkObject under File > Options >

Painting > Connections.
When connected to the real robot, the mapped workobject values
are updated from the real robot into RobotStudio.

Programs

• Configure Users and Groups, see Login and access control on
page 94.

• Enable User Authentication option.
• Ensure that the UAS.xml is copied to

[$:\ProgramData\ABB\Painting\UserAccess].

UAS (optional)

• Remove the paths and workpiece details from the station as this
is loaded automatically on the shop floor .

• Save the station.
• Mark the [$StationName].rsstn station as read-only to avoid

editing of the paint cell on the shop floor.

Station

• The workpiece libraries must be placed in the location defined
under the RobotStudio option File > Options > Painting >General.

Note

To associate workpiece with collision sets, see Associate collision sets
with workpiece on page 61.
To associate workpiece with path, see Associate procedure and work-
piece on page 63.

Workpiece
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3.8 Edit paint programs

Editing paint programs on the shop floor
When the station PC is prepared for operations the following steps are followed
for shop floor editing.

DescriptionActionStep

Start RobotStudio station.1

Login with the credentials defined under
User authentication system.

2

For more details, see Login and access
control on page 94.

Connect to a real Paint robot.3

The modules are fetched from the real
controller.

Load Programmodules andworkpiece into
RobotStudio.

4

The Workpiece is positioned in front of
the robot.

The modules can be automatically
mirrored or copied to other robots in the
station. For more details, seeDistribution
rules on page 90.

Edit the path and save.5

Validate the changes by executing the
simulation.

6

Capture comments for the changes in a
log file.

Transfer files to the real robot.7

Disconnect.8

To prevent accidental editing do not save
the station if prompted.

Close the station.9
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4 Painting PowerPac
4.1 Manage programs

4.1.1 New program

Overview
A paint program is identified by a unique number which is called upon for execution
by the robot controller or PLC . The program.map file stores the information about
the program numbers.
Painting PowerPac allows you to create programs and make the necessary
configurations for enabling shop floor operations in RobotStudio.

xx1600001665

The program refers to several RAPID modules which are loaded into the controller
when the program is selected. The association with the modules is usually defined
within the Main module.

Continues on next page
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Create a new program
The following steps describe the procedure for creating a new program using
Painting Powerpac:

ActionStep

In the Program group click Manage.1
The Manage window is displayed.

xx1600001476

Click New under Programs section.2
The Create New Program window is displayed.

xx1600001477

Validate or edit the program details.3
If you choose to create an empty program, the modules have to associated
manually. If you choose create a new program based on an existing program,
newRAPIDmodules are created based on themodules associatedwith the existing
program.

Click Create.4
The Program Details window displays the details of the new program.

Continues on next page
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ActionStep

ClickNew to create a newmodule or clickAddModules to select and add existing
modules to the program.

5

In the Advanced tab, underWorkobjects section, click Add Workobject.6
A blank row is added to the list.

xx1600001666

From the Wokobject list in the Name column select a Workobject.7
The name of the module associated with the selected Workobject is updated in
the Module Name column.

Note

If you want to make the selected Workobject as the reference for the workpiece,
select the corresponding radio button in theWorkpiece Reference column.

In the Libraries section click Browse and select a . rslib library file.8
The selected library file is added to the Libraries section.

Note

If the selected library file is not present in the workpieces folder X icon.

Select a spray fan from the Spray Fan list.9

Click Apply.10
The program.map file is updated with the new program details. This file is located
under $<systemname>/HOME/alias folder.

Note

Modules are created or copied under $<systemname>/HOME/programs folder.
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4.1.2 Load program

Overview
The Load feature loads selectedmodules and workpiece associated with a program
into RobotStudio station. If connected to a real robot, the modules from the real
robot are loaded into the station.
The modules and workpieces association with the program is configured under
manage programs.

Loading a program
The following steps describe the procedure:

DescriptionActionStep

xx1500002112

Click Load from theProgram group.
The Load window is displayed.

1

Select the required program from
the Program list.

2

The modules associated with the selected
program for the selected robot are displayed
in the Modules section.

Select the required robot from the
Robot list.

3

To select all the available modules you can
use the Select All button.

Select the modules.4

The workpiece associated with the selected
program for the selected robot are displayed
in theWorkpiece list.

Select the Load Workpiece check-
box and select the required work-
piece from theWorkpiece list.

5

The selected modules and workpiece are
loaded in RobotStudio. The workpiece is
placed with reference to the workobject con-
figured under manage programs.

Click Load.6

Continues on next page
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Following are some of the scenarios while loading a program.

xx1500002113

DescriptionScenario

In this case the icon is displayed against
the module. You will not be able to load this
module.

Scenario 1: The module is not found in the
real controller or in the local

The icon is displayed next to the module.
In this case if you select this module and click
the Load button the local version is loaded.

Scenario 2: The module is not present in the
Real Robot Controller, but present in the
local.

The icon is displayed next to the module.
In this case when you select the module a
drop-down list is displayed next to it.

xx1500002114

Scenario 3: If there is difference between the
versions in local and robot.

The Compare button displays the difference
in the files. If you choose to load the version
from the Real Robot Controller it overwrites
the local version before loading into Robot-
Studio station.
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4.1.3 Edit paint programs

Overview
Paining PowerPac provides easy navigation to the instructions or targets either
from the browser tree or the graphical window to edit or create paint paths using
the functions described in the following sections.

Modify target
To modify the properties of a target:

DescriptionActionStep

Select the target either directly from
graphical window or from the
browser tree.

1

xx1500002158

In theModify group clickProperties.
ThePropertieswindow is displayed.

2

The Links section displays the links to the
associated instructions. Click on an instruc-
tion link to edit its properties. For more de-
tails, see Modify instruction on page 37.

Edit the target position or orientation
directly or with an offset.
The changes are applied immedi-
ately for the selected target.

3
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Modify instruction
To modify the properties of an instruction:

DescriptionActionStep

Select the instruction either directly
from graphical window or from Pro-
gramming Instructions tree.

1

xx1500002159

In the Modify group click Proper-
ties.
ThePropertieswindow is displayed.

2

The Links section displays the links to the
associated target and Setbrush. Click on a
link to modify its properties. For more details,
see Insert motion instructions on page 38,
Insert action instructions on page 39, and
Modify event on page 40.

Edit the instruction parameters ac-
cording to your requirement.
The changes are applied immedi-
ately for the selected instruction.

3

Modify JointTarget
Tomodify the JointTarget values of RobotAxes and the ExternalAxes, you can use
the Properties pane.

DescriptionActionStep

Select the JointTarget either directly
from the graphical window or from
the browser tree.

1
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DescriptionActionStep

xx1800000573

In the Modify group click Proper-
ties.
ThePropertieswindow is displayed.

2

The Links section displays the links to the
associated JointTarget instructions. Click the
link to modify its properties.

Edit the JointTarget – Robot Axes
or External Axes directly or with an
Offset.

3

The changes are applied immedi-
ately for the selected target.

Insert motion instructions
Use the following procedure to insert motion instructions:

DescriptionActionStep

Select an instruction listed under a
procedure from Programming > In-
structions tree.

1

xx1600001579

Right-click the Instruction and then
click Insert Move Instruction >
PaintL.
The Create Move Instruction Pane
opens with the selected instruction
template.

2

Continues on next page
38 Operating manual - Painting PowerPac

3HAC054618-001 Revision: J
© Copyright 2020 ABB. All rights reserved.

4 Painting PowerPac
4.1.3 Edit paint programs
Continued



DescriptionActionStep

In the Graphics window, select the
required points where the new tar-
gets for adding instructionsmust be
created.

3

The selected points gets added and
listed in the Points box.

xx1600001581

Click Create.
The selectedmotion instructions are
created with LOCAL targets.

4

Insert action instructions
Use the following procedure to insert action instructions:

DescriptionActionStep

xx1600001578

Select an instruction listed under a
procedure from Programming > In-
structions tree.

1

xx1600001582

Right-click the Instruction and then
click Insert Action Instruction >
SetBrush.

2

xx1600001583

SetBrush Instruction is added in
the middle of the selected path
which can further be edited either
graphically or using the edit event
function. For more details, see
Modify event on page 40.

3
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Modify event
To modify the properties of an event.

DescriptionActionStep

Select the Setbrush from browser
tree.

1

xx1500002160

In the Modify click Properties.
ThePropertieswindow is displayed.
From this window you can change
the brush number, trigger position,
and other brush parameters.

2

TheBrush Details section displays the brush
parameters for the brush number for a selec-
ted brush table.

Note

The trigger event is validated based on the
position on the path segment and the zone
information of the next path segment. This is
indicated graphically. For more details, see
Graphical window on page 15.
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DescriptionActionStep

The Links section displays the links to the
associated instruction. Click on a link to
modify its properties. For more details, see
Modify instruction on page 37.

Edit the instruction parameters ac-
cording to your requirement.
The changes are applied immedi-
ately for the selected instruction.

3

Target reachability
The Reachability feature allows you to verify the reachability of all the targets.
To verify the reachability:

DescriptionActionStep

Select a procedure or the targets
listed under a procedure from the
browser tree.

1

xx1500002164

Click Reachability from the context
menu option of the path procedure.
The Reachability window is dis-
played.

2

The reachability status for all the targets un-
der a selected procedure are displayed. The

icon next to a target indicates that the tar-
get is not reachable. The icon next to a
target indicates that the target is reachable
in the current position. The icon next to
a target indicates that the target is not
reachable with the current configuration but
may be reachable with other configurations.

Double click on a target to navigate
to its position in the graphical win-
dow.

3

Continues on next page
Operating manual - Painting PowerPac 41
3HAC054618-001 Revision: J

© Copyright 2020 ABB. All rights reserved.

4 Painting PowerPac
4.1.3 Edit paint programs

Continued



Validate trigger events
The Events feature allows you to verify the state of the SetBrush instructions.

DescriptionActionStep

Select a procedure or setbrush lis-
ted under a procedure from the
Programming Targets tree.

1

Right click on the selected proced-
ure.

2

The context menu is displayed.

xx1500002165

Click Events.
The Events window is displayed.
The trigger event is validated based
on the position on the path segment
and the zone information of the next
path segment. This is indicated
graphically. For more details, see
Graphical window on page 15.

3

The state of the SetBrush instructions is dis-
played. Following are the possibilities:

• - SetBrush Valid
• - SetBrush lies on path but within

the zone. It depends on the sub-
sequent path segment to determine
whether it triggers or not.

• - SetBrush lies outside the path
segment.

Note

You can type a brush number in the Lookup
Brush field to display only those instructions
referring the brush number.

Double click on a SetBrush instruc-
tion to examine it in the graphical
window.

4
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Verify the robot motion
The Move To function enables you to verify the robot motion along a path and
identify the reachability and configuration issues, if any.
Use the following procedure to verify the robot motion:

1 Click File > Options > Painting >General > Move To Default Speed.
2 Set the speed of simulation.
3 In the programming browser tree, right click on the path

procedure/instructions.
4 Select Move To.

The program execution starts and the simulation progresses with the
configured speed. The respective instruction is highlighted on the browser
tree.
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4.1.4 Semi automatic path generation

Overview
This function enables you to generate path on workpiece panels. The path pattern
is based on the type of the paint equipment (spray gun or atomizer) attached to
the robot, parameters such as pitch, offsets, path direction and so on which can
be tuned.
Following are the pre-requisites for using Auto Path:

• A program is created and listed in the Painting PowerPac browser window
• The workpiece is imported and panels are identified on it.
• The parameters in the Preferences dialog are set.

Auto path
To access auto path, on the browser tree select the Component tab and right-click
on a panel inside a workpiece as shown in the following figure.

xx1100000855
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From the context menu select Auto Path. The Auto Path window is displayed.

xx1100000856

The following table provides you the procedure for selecting the values in theAuto
Path window.

DescriptionOption

Robot: Displays the robots available in the station.Select
Module: Displays the modules that are loaded into
the station for the selected robot.

Tool: Displays all the tool data associated with the
selected robot.

Instruction Parameter

Workobject: Displays all the workobjects associated
with the selected robot.

Allows you to choose a painting type. The available
options are Spray Gun and Atomizer.

Painting Type

For more details see, Path parameters on page 51.

Continues on next page
Operating manual - Painting PowerPac 45
3HAC054618-001 Revision: J

© Copyright 2020 ABB. All rights reserved.

4 Painting PowerPac
4.1.4 Semi automatic path generation

Continued



DescriptionOption

Path Direction
Displays the possible path directions.

xx1100000857

Specify the path on the selected panel with Path Dir-
ection. You can choose the direction of the path as:

• Along Long Edge - When the program is cre-
ated along the longest side of the Panel (here
the length of the box)

• Along Middle Edge - When the program is
created along with less longer side of the
Panel (here the breadth of the box)

• Along Short Edge - When the program is cre-
ated along the shortest side of the Panel (in
this case the vertical side of the box)

Starting Corner
Select the starting corner of the path as 1, 2, 3, or 4
as required. Then clickCreate to create the path. The
other points can be located bymoving in the counter-
clockwise direction from the current starting corner
point.

xx1100000858

Path Parameters

Pitch
Pitch describes the distance between two parallel
paths. You can change the Pitch value from the win-
dow.
Path Offset: Defines the distance from the starting
corner edge and the path. This is usually half of the
pitch value.
Rotation: Rotates the path by the specified value.

Start Brush Number: Allows you to change the start
brush number.

SetBrush

End Brush Number: Allows you to change the end
brush number.

Note

The set brush number is used while creating the path.

Creates the path. Individual paint strokes are identi-
fied and appended to a procedure with the name as-
sociated with the panel. The name of the procedure
is similar to the corresponding panel name.

Create
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Manual Paint Stroke
The Manual paint stroke option allows you to create the paint path by the selection
made in the Part of the Graphics which creates the corresponding RobTargets and
Instructions. Also, while completing the path, SetBrush gets created after the first
RobTarget and before the last RobTarget.
To access Manual Paint Stroke, on the browser tree, right-click on an instruction
or a procedure and select Insert Paint Stroke from the context menu.
The Manual Path window is displayed.

xx1800000531

The following table provides you the information about the fields in the Manual
Path window.

DescriptionOption

Displays the robots available in the station.Robot

Displays the modules that are loaded into the station for the
selected robot.

Module

Tool: Displays all the tool data associated with the selected
robot.

Instruction Parameter

Workobject: Displays all the workobjects associated with the
selected robot.
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DescriptionOption

Allows you to choose a painting type. The available options are
Spray Gun and Atomizer.

Painting Type

For more details see, Path parameters on page 51.

Start Brush Number: Allows you to change the start brush
number.

SetBrush

End Brush Number: Allows you to change the end brush
number.

Note

The set brush number is used while creating the path.

To delete all the created RobTargets/ Instructions.Clear

To start/finish creating the RobTargets.Start/Finish

Allows you to position the targets accurately while using
manual paint strokes. For more details see, Creating grid on
page 48.

Show Create Grid

To close the window.Close

Creating grid
A grid is created to position the targets accurately while usingmanual paint strokes.
Use the following procedure to create a grid:

1 In the Manual Path window, click Show Create Grid
The Create Grid window is displayed.

xx1900001179
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2 In the graphical window select the parts for which the grid needs to be
created.

Note

Hold the SHIFT key and select the parts for multiple selection. The selected
parts name is displayed in the Select Parts list.

3 Configure the following settings:
• Pitch: Specify the pitch value in mm. The pitch value defines the

distance between grid lines.
• Show/Hide along: Select the required check boxes to see the grid lines

along a specific edge.

Note

Click Clear to clear all the grid lines.

4 Click Create.
The grid is created for the selected parts. The grid of the model is created
based on the world coordinates.

Note

When you select another set of parts and create a grid, the previous grid is
deleted. When theManual PaintStroke dialog is closed, all the grids are deleted.

PaintStroke Node
Paintstroke node is a group of instructions starting from the first paint instruction
till it finds the next first paint instruction coming after end SetBrush. Likewise
multiple PaintStroke nodes are created once you set the SetBrush as end SetBrush.
The instructions in a path procedure are grouped into PaintStroke nodes depending
on the end SetBrush number. Individual paint strokes are identified and appended
to a procedure.

Note

On activating Painting PowerPac, the PaintStrokes are created according to the
end SetBrush defined in Path Parameters window.

Note

The paths created using Autopath and Manual Path functionalities contain the
PaintStrokes, which are created using the end SetBrush numbers defined in the
corresponding windows.
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Creating PainStroke node
Use the following procedure to create PaintSkroke node:

1 Select the SetBrush instruction to be defined as End SetBrush.
2 Right click on the selected SetBrush instruction.

Context menu is displayed.

xx2000001863

3 From the context menu, select Set As End Brush.
PaintStroke node is created according to the defined end SetBrush.

xx2000001901

Note

The instructions other than PaintStoke instructions are grouped into Support
Instruction node.
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Path parameters
You can use thePath Parameterswindow to adjust the parameters used to generate
paint path. To access this in theSettings group, clickConfigure >Path Parameters.

xx1100000846

The following table describes the options available in the Path Parameterswindow.

DescriptionOption

This section defines the default PaintL and SetBrush instruction
values for different scenarios.

• Paint Speed: Defines the velocity of the TCP while
painting.

• Paint Zone: Defines the Zone value while painting.
• Transport Speed: Defines the speed of the PaintL in-

struction when the robot is not painting, that is, when it
is moving between the paint strokes.

• Transport Zone: Defines the zone value to be used for
the PaintL instruction when the robot is not painting,
that is, when it is moving between the paint strokes.

Default Instruction Para-
meters - Paint

Following are the SetBrush parameters:
• Start Brush Number: Defines the brush number to be

used for turning ON the paint flow.
• End Brush Number: Defines the brush number to be

used for turning OFF the paint flow.

Default Instruction Para-
meters - SetBrush
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DescriptionOption

This section allows you to adjust the common parameters for
the path pattern of spray gun and atomizer.

• Approach Offset: A: Defines the value (mm) which
specifies the distance the robot has to travel before
turning ON the paint flow. This is the distance in which
the robot needs to reach the programmed TCP speed.

• Depart Offset: D: Defines the distance the robot has to
travel after turning OFF the paint.

• Trigger On : O1: Defines the distance the robot has to
travel before turning ON the paint. A brush event is
created at this point.

• Trigger Off : O2 Defines the distance the robot has to
travel before Turning OFF the Paint flow. A brush event
is created at this point.

• Pitch: P: Defines the distance between two parallel paint
strokes.

• Hole Width: H: Defines the minimum size of any hole
that is identified during path generation. For the identi-
fied holes, targets are created at the starting and ending
point after the path generation.

Note

A hole can be any gap on the divided model. If there are
holes in the panel and along the path, and the size of
the hole is larger than the specified value in the template,
then targets are created at the starting and ending point
of the hole along the path. You can add events at these
positions. Holes that are smaller than the specified size
are ignored.

• Path Offset: E: Defines the distance from the starting
corner edge and the path. This is usually half of the pitch
value.

Path Settings

Following are the stay on parameters:
• Reduced Flow Brush number: Defines the brush num-

ber used for reducing the paint flow when robot is mak-
ing a turn.

• Reduced Flow Offset: O3: Defines the offset distance
(in mm) before which the reduced flow event must be
inserted before starting the turning operation and the
distance turning before which the normal brush event
is inserted.

• Turning Zone: Z: Defines the Zone information used for
the PaintL instructions which are used to make a turn
in Stay-On painting.

• Turning Offset: O4: Defines the distance (in mm) the
target is offset from the path direction when making a
turn.

• Edge Offset: O5: Defines the distance (in mm) of the
target from the edge of the Panel.

Atomizers

Some scenarios

Scenario 1
RobTarget Z- axis is not pointing normal into the surface
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In some CAD models the Z-axis may be pointing out of the surface. Here you can
choose Adjust Position and Orientation option from the context menu of the
PaintStroke to rotate the RobTargets by 180 degrees.

Scenario 2
Atomizer painting is creating paint strokes which are not similar to the template
In such cases the Pitch and Edge values are not proportional to the edge length.
Modify the same to be proportional with the size of the edge along the path direction.

Scenario 3
Auto path process is time consuming.
Possible reasons for this are large number of parts in the panel, complex panel
shape, multiple layers in the selected CAD model, and so on. The suggested
solutions are:

• Simply the panel by expand/divide functions.
• Optimize the number of parts in the panel.
• Ensure that panel parts do not have duplicate layers.

Some CAD models may have multiple layers. You may have selected only the top
surface of the workpiece while creating the Panel. However the path generated
may not be as expected. An example of multiple layers is shown in the following
figure.

xx1100000864

In a case, as shown in the figure, delete all duplicate layers and leave only one
layer which defines the surface to be painted.
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4.2 Manage brush parameters

Overview
You can manage brush parameters using the Brush table editor. On the virtual
controller the brush tables are stored under $<Systemname>/IPS/A1Brush folder.
When connected with a real robot, the brush tables are fetched and updated to the
above folder.

Note

For RobotWare 6.07 and onwards, the brush tables are stored in sub-folders
under the A1Brush folder. The sub-folders are automatically created and stored
based on the Brush Table number.

xx1500001907

Define brush table
To define a brush table:

DescriptionActionStep

Click Brush Tables on the Editor
group in the Painting ribbon Tab.

1

The Brush Editor window is dis-
played.

Note

The option for folder selection will be avail-
able for the systems with RobotWare 6.07
and above.

Select the robot from the Robot list
for which you want to access the
brush table.
Select a folder from the available
folder list for the selected robot.
The available brush tables from the
selected robot & the selected folder
will be displayed in theBrush Table
list.

2

Click the Import button to import an existing
brush table from another location.

Click New.
The Create New Brush Table win-
dow is displayed.

3

Type value in the Brush Table
number field.

4
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DescriptionActionStep

Type value in the Number of
brushes field.

5

Click OK.6
A new brush table is created and
the default values are loaded in
various fields.

To edit using the chart the option must be
enabled from File > Options > Painting >
Tables.

Type the values in various fields or
edit using the chart.

7

Click the Export button to export the newly
created brush table for reuse.

Click Save.
The new brush table is saved under
the system folder.

8

The following scenario can occur while editing brush tables on the real paint
controller:

DescriptionScenario

If a different version of Brush Table exists on
the controller, the icon is displayed next
to the Brush Table. Select the version of
Brush Table to be loaded.

Scenario: If there is difference between the
brush table values in local and real robot.

The Compare button displays the difference
between the files. In this case when youmust
choose the version. If you choose to load the
version from the Real Robot Controller it
overwrites the local version. However if you
choose the local version the version on the
real robot remains the same.

xx1600001667
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4.3 Manage Workpiece

Preparing Workpiece
Prepare the workpieces associated with the paint programs according to the
following guidelines:

• Identify Panels on the workpiece to enable show/hide path and graphics
information in RobotStudio.

• Simplify the workpiece geometry to reduce the complexity and size.
• Save the workpiece as a RobotStudio library (*.rslib format) within a folder

with the same name as the RobotStudio Library.
The information corresponding to workpieces are saved in
C:\ProgramData\ABB\Painting\Workpieces as shown in the following figure.

xx1500002602

Workpiece configuration file
The Workpiece configuration file defines the following additional configuration
related to a workpiece library:

• Defines the collision sets in the workpiece.
• Defines the configuration smart component details related to simulating the

opening and closing of the workpiece mechanisms (for interior painting).
When a workpiece is loaded into RobotStudio station, the collision sets are created
in RobotStudio and the smart components are configured. This information is used
during Program simulation. The configuration XML is placed in the same folder as
the workpiece library and shares the same name with a Configuration extension.
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Workpiece configuration file is described in the following table:

DescriptionSection

The name of the workpiece is mentioned in
the WorkpieceSetup Name node.

xx1500002643

Aworkpiece can be imported into any Robot-
Studio station, however the collision sets and
smart components are different for each sta-
tion.xx1500002644

The configuration file provides the option to
specify the information of the RobotStudio
station under thePaintCellSetupName node.

The collision sets and smart component de-
tails are configured for each station.

Note

The StationSignal Name node is not used.

xx1500002645

The AdditionalLibraries node lists the
smart components defined in the workpiece
whose behavior is to be configured.

xx1500002646

The child smart components and their beha-
vior is defined in these nodes.

xx1500002649

The collision sets configured for the station
in relation with the workpiece is defined in
these nodes.

xx1500002647

The subsequent child nodes define the colli-
sion set properties and objects.

xx1500002648

CAD model simplification-Split part by
The Split Part by function provides options to process themodel by creating panels
and paint strokes on the workpiece. The following Split Part by options are
available:

• Body/Face: For showing the internal structure of the selected part by
identifying the bodies as sub-parts. This option exposes the internal structure
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of the workpiece as individual selectable parts. This helps to identify panels
on the workpiece.

• Gap: This option meshes (sub-divides) the selected parts to triangular
surfaces. This helps to identify the surface normals while creating paint
strokes. New parts may be created based on the gaps in the CAD model.

To divide a workpiece:

DescriptionActionStep

Select part selection icon from the
Selection Level on the graphics
window and select the required
workpiece from the graphics win-
dow.

1

xx1600001478

Right click and selectModify > Split
Part by > Body/Face/Gap.

2

If you select the Gap option the parts that are
already expanded are meshed into triangular
bodies. The parts that are not expanded or
can be further expanded are not meshed.

The selected split part by process
is done.

3

Note

Processing a workpiece to divide it into smaller parts depends on the format,
size, complexity, and the level of the detailing in the work piece. If the work piece
is highly detailed and large in size, then the process takesmore time to complete.
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Identify panels
The unique parts of a workpiece that can be grouped together is termed as a Panel.
For example, Door, Hood, and so on.
To create a new panel use the following procedure:

InformationActionStep

By default the the name of the panel is
Workpiece name_Panel_1, Workpiece
name_Panel_2, and so on. You can right click
on the panel and rename it. For example,
Hood, Door, and so on.

xx1600001364

Right click on the work piece and
select New Empty Panel.
A new empty panel is added to the
selected workpiece.
The Panels window is displayed.

1

The selected parts are added to the Panels
window.

Click on the surface of the work-
piece and select the parts according
to your requirement.

2

The panel is created and listed in the Panel
Browser window below the corresponding
workpiece.

Click Apply3

To edit the panel.Right click on the panel and select
Edit Panel.

4

For more details, see Semi automatic path generation on page 44.

Shape panels
The shape panel functionality allows you to divide or extract a Panel along a number
of cutting planes which intersect the parts along each axis. The cutting planes are
placed such that the workpiece is divided equally into the number of planes along
each axis. You can shape the panel by specifying the number of cutting planes
along each of the X, Y and Z axes.
Shape Panel - Cutting planes
The shape panel cutting planes option allows you to divide a Panel along a number
of cutting planes which intersect the parts along each axis.
To cut planes:

InformationActionStep

Select the panel for which you want
to cut the planes from the browser
tree.

1
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InformationActionStep

xx1600001464

Right click on the panel and select
Shape Panel > Cutting Planes.
The Panels using Cutting Planes
window is displayed.

2

Type the number of cutting planes
in Short Edge, Long Edge, and
Middle Edge fields.

3

xx1100000834

Click Preview to view a preview of
the cutting planes on the Panel.

4

The new panels are listed in the Panel
Browser tree below the corresponding work-
piece.

Click Apply
The parts in the panel are divided
along the cutting planes and the
parts within each plane are identi-
fied as a Panel.

5

Dividing a workpiece during importing, breaks it into smaller parts along the natural
gaps on the surface. Hence it may not always identify one half of the car body by
selecting parts. In this scenario the functionality of being able to shape an existing
panel helps in identifying different panels along different sections uniquely.
You can customize the cutting planes’ position using RobotStudio options Freehand
Move or Rotate.
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Associate collision sets with workpiece
Use the following procedure to associate collision sets with wokpiece:
To associate collision sets with workpiece:

DescriptionActionStep

xx1600001586

Select the required work-
piece for associating the
collision set.

1

xx1600001588

Right-click the selected
workpiece, select Associ-
ate Collision Sets and
then click the required
CollisionSet.

2
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DescriptionActionStep

xx1600001587

A check mark appears
near the selected collision
set and the collision set is
associated with the work-
piece.

Note

To separate the collision
set from the workpiece
click on the the selected
collision set again.

3

Continues on next page
62 Operating manual - Painting PowerPac

3HAC054618-001 Revision: J
© Copyright 2020 ABB. All rights reserved.

4 Painting PowerPac
4.3 Manage Workpiece
Continued



Associate procedure and workpiece
To associate procedure and workpiece:

DescriptionActionStep

xx1600001590

Select the required workpiece for
associating the procedure.

1

xx1600001591

Right-click the selected workpiece
and then click Associate proced-
ure.
The Associate Procedure dialog
opens.

2
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DescriptionActionStep

xx1600001592

From the listed procedures, select
the panels to associate.

3

Click Apply.4
The workpiece is associated with
the procedure. This association in-
formation is used in the Show/Hide
function.

Note

After associating procedures with the corresponding panels of the workpiece,
save this information as a library file [$Workpiecename].rslib for the further use
on the shop floor.
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4.4 Simulation

4.4.1 Overview

Simulation
Painting PowerPac offers a number of options to simulate and run a paint cell with
multiple robots including conveyor tracking.
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4.4.2 Executing a simulation

Procedure
Use the following procedure to execute a simulation:

DescriptionActionStep

The list displays the programs from all the
paint controllers in the RobotStudio station.

In the Simulation Control group
select a program from the list.

1

The programs are executed similar to job
queue. For more details, see Job Queue on
page 67.

Click Play.
The program is appended to the
controllers, conveyor is reset, and
the simulation starts.

2

The programs are appended to the controllers
if the simulation entry point is MAIN. This is
defined set under Simulation Setup in the
Simulation Control group.

xx1600001668

You can tune the behavior of the simulation
using File >Options >Painting >Simulation.
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4.4.3 Job Queue

Overview
The JobQueue functionality allows to create a sequence of programs for execution.
The following are the pre-requisites for using the Job Queue:

• Programsmust be saved under $<Systemname>/HOME/programs folder.
• The mapping files, program.map and material.map files must be prepared.

The files can be located under System/HOME/alias folder. For more details,
see Distribute programs on page 84.

Usage

xx1600001465

To access Job Queue, in the Simulation Control group, click Configure > Job
Queue. The Job Queue window is displayed. This window displays the jobs in the
Queue and the currently executing job.

xx1600001466
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The following table describes the options in the Job Queue window.

DescriptionOption

To append a job to the controller/controllers.Append

To Insert a job before the selected job.Insert

To edit a selected job.Edit

To delete a selected job.Delete

To delete all the jobs in the selected controller.Clear

When running the job in Production mode, you can
Inhibit (pause) and Resume the production.

Inhibit/Resume

Appending a job
You can append a job to the job queue for the selected robot or for all the robots
the station.
To append a job:

DescriptionActionStep

xx1600001479

Click Append.
The Job Queue - Append window is
displayed

1

SelectCurrent Robot orAll Robots
as required.

2

Note

The Quantity option defines the number of
times the program must be executed.

Select a program from the Program
list, and material from the Material
list.

3

Click OK4
The selected job is added to the job
queue.

To execute programs through job queue the
simulation entry point is MAIN. This is defined
set under Simulation Setup.

Click Play.
The simulation starts and programs
are executed in sequence .

You can tune the behavior of the simulation
using File >........
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Simulating the production
After appending jobs to the queue, you can view a simulation of the production by
clicking the Play button from Graphics window or from the Simulation tab in
RobotStudio. To start the production the Entry point must be in the main module.
If you open the Job Queue window when no simulation is running, then the entry
point for each controller is set to their corresponding main procedures.

Inhibiting and resuming production
You can pause and resume the production at any point. To pause a production,
click Inhibit. To resume the production, click Resume.
When a program is paused during execution, it completes the currently executing
task and then pauses. However, the simulation status does not change to Stop
and the controller remains in the Start state. When resumed, the production
continues as normal.

Note

Clicking Inhibit or Resume does not affect the execution of high priority jobs
such as HomePos.

Tip

• Sometimes jobs might not be appended to the controller because controller
might give Socket error, Try to Close and Re-open the Job Queue window
and try again.

• If you are not able to append jobs to the controller because of any reason,
restart the controller and then try again.
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4.4.4 Batch simulation

Running a batch simulation
Batch simulation is used to run simulation repeatedly with different initial states
or scenarios for each simulation instance. This saves time by automating the
simulation scenarios.

ImageActionStep

xx1600001484

In the Simulation Control group
click on the Configure button.
The context menu is displayed.

1

Click Batch.2
The Batch ribbon tab is displayed
with the required options.

In the Manage Batch group click
New Batch button.

3

A new batch is created under Man-
age Batches in the Batch window.

Select the newly created batch.4

xx1600001485

Right click and select Edit.
The Configure Batch Parameters
window is displayed.

5
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ImageActionStep

xx1600001485

Click the Add Item button.
TheConfigure Batch Itemswindow
is displayed.

6

Select a parameter from the Para-
meter Type section.

7

The corresponding options are dis-
played below it. Select the options
according to your requirement.

Once the required options are con-
figured click Apply.

8

The item is added to the List of
Batch Items section.

Continue adding more items for the
selected Batch ID.

9

Once you finish adding all items for
a Batch click Close.

10

TheConfigure Batch Itemswindow
is closed. The configured items for
the selected batch ID is available in
the List of Batch Items section.
To add more items under a new
Batch ID, click the Add Item button
and repeat the previous steps.

Once all the items are added click
Close in the Configure Batch
Parameters window.

11

In the Batch ribbon, Batch group,
select the required batch from the
Select Batch list.

12
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ImageActionStep

Click the Execute button.13
The simulation is executed for each
Batch ID sequentially.
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4.4.5 Spray fan

Overview
Spray Fan allows you to set the brush properties used by Painting PowerPac.
These Brush properties are not used by the robot controller directly, instead it is
used by Painting PowerPac to identify PaintStrokes.
Creating a Paint program requires a Spray Fan specification to be defined in the
station. For each brush number, the Spray Fan specification has the following
information:

• Width in mm
• Length in mm
• Spray Distance in mm
• Color

TheWidth and Length information is used while creating/identifying paint strokes.
The Color information in a Brush number is shown on the path. TheWidth and
Length represent the pattern of the spray for the corresponding Brush number.
For example, a value of 0 forWidth and Length indicates that the corresponding
brush number is used to Turn-Off the paint. This information is used when loading
the existing Paint programs. It is important to create the appropriate Spray Fan
specification such that the PaintStrokes are identified correctly.

xx1100000842

When you open a painting station or when you open painting PowerPac the smart
components of Spray Fans are automatically created. You can access these smart
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component of Spray fans from Home tab > Layout browser tree as shown in the
following figure.

xx1600001473

Creating a Spray Fan table
You can create a new Spray Fan Table.
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To create a Spray Fan table:

InformationAction

xx1600001469

In the Components programming
tree right click on the Spray Fan
Table folder.
The New Spray Fan option is dis-
played.

1

The new spray fan table is added as a station
document. You can access this document
from Home Tab > windows document win-
dow.

Select the New Spray Fan option.
The new spray Fan is added to the
Spray Fan Table folder with the de-
fault options and Spray Fan Tables
window is displayed.

2

xx1600001471

Edit theWidth, Length, or Spray
Distance parameters for a particular
brush number according to your re-
quirement.

3

Click Apply.4
The changes are saved.
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InformationAction

To edit the spray fan table.

xx1600001470

Right click on the Spray Fan Table
folder and select the Edit option.

5

Configuring the default properties of Spray Fan Table
You can configure the default properties of Spray Fan table.
To configure the default properties of spray fan table:

InformationActionStep

In the File tab click Options.1
The Options window is displayed.

xx1600001472

Navigate to the Painting section and
select Tables.
The Tables window is displayed.

2

Navigate go the Spray Fan Table
Settings section and edit the De-
fault prefix name and Default row
count according to your require-
ment.

3

Click Apply.4
The changes are saved.

Click OK.5

Once the settings are saved, when you create a new Spray Fan Table the settings
saved here are applied to the new table.
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4.4.6 TCP trace

For information regarding TCP trace, refer Operating manual - RobotStudio.
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4.4.7 Conveyor tracking

Synchronization Offset
Shopfloor simulation Painting PowerPac extends the conveyor tracking feature in
RobotStudio by providing theModify SynchronizationOffset function. This feature
brings the conveyor simulation more closer to the actual paint lines. The Modify
Synchronization Offset function is accessible from the context menu of the
Conveyor:

xx1500002674
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Usually the sync-signal is set by the Offset parameter in the Modify Connection
window. It gives the distance from the conveyor start to the robot’s base frame:

xx1500002675
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If the sync-signal has to be set apart from the offset value, you can adjust the
sync-signal separately from the Synchronization Switch Offset window.

xx1500002676

Note

The synchronization offset value should be according to the formula
Offset+Sync-Signal Offset > 0.
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4.5 Reporting functions

4.5.1 Overview

Reporting function
This function allows you to record information during simulation. The data can be
analyzed to calculate the consumption details and analyze the error logs.
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4.5.2 Generate report

Generating a report
The options available in the Reports group allows you to manage the reporting
functions.

xx1600001468

Use the following procedure to generate a report:

DescriptionActionStep

In the Reports group, select the
Enabled option.

1

The reporting functionality is en-
abled.

In the Simulation Control group,
click Play and run the simulation.

2

The events are recorded with the
simulation.

In theReports group, clickAnalyze.3
Opens the latest available report
from the history.

xx1600001671

Click History.
The History window is displayed.
The History window displays the
report of all the simulations that are
run after you selected the Enabled
option.

4
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4.5.3 Analyze report

Analyzing a report
Information from each simulation is captured in the reports and is available for
further investigation. The report analysis feature provides information about paint
consumption, gun on time, and other parameters. It also captures the simulation
event logs such as collision, warnings, and so on, with an option to view the robot
or conveyor at the position where event occurred. This helps in better problem
solving.
To analyze and view a report:

DescriptionActionStep

xx1600001672

Select a report from the History
window and right-click.
The context menu is displayed.

1

The report has two sections, paint consump-
tion and output log.

Select Analyze.
The analysis of the selected report
is done and the report is displayed
at the bottom of the screen.

2

xx1600001669

Paint Consumption: This section
displays the details of programs that
are executed in the simulation in-
stance. Select a brush table for ro-
bot and get an estimate for the con-
sumption and the gun on time.

3

xx1600001670

Output logs: This section lists the
event logs for the simulation in-
stance. Examples are Controller
messages, collisionmessages, and
so on.
Right-click on an event log ( for ex-
ample, collision) and select an op-
tion to view the robot and conveyor
at the log event position. This
moves the robot and conveyor to
the closest position when the log
was reported. This helps to solve
issues quickly.

4

Operating manual - Painting PowerPac 83
3HAC054618-001 Revision: J

© Copyright 2020 ABB. All rights reserved.

4 Painting PowerPac
4.5.3 Analyze report



4.6 Distribute programs

4.6.1 Overview

Distribute programs
Programs in Painting PowerPac (RAPID modules, Brush Tables, and so on) can
be copied or mirrored to other robots in the RobotStudio station and transferred
to the real robots on the paint line. The following sections describe the various
options and settings for this activity.
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4.6.2 Save programs

Saving a program
The save feature allows you to save changes in a program for a selected robot.
The changes to the program are saved in the system folder
(<systemname>//HOME/Programs). The Save button is enabled if a program has
been edited in RobotStudio.
Use the following procedure to save the changes to a program:

DescriptionActionStep

xx1500002161

Click Save from the Program group
on the Painting ribbon tab.
The Save window is displayed. The
changed files (modules, index, and
mapping files) are listed.

1

Note

TheEDIT label next to amodule denotes that
the file is changed.

xx1500002162

The changes for a particular robot
can be copied or mirrored to other
robots based on defined rules. For
this select the Save to other robots
in the station checkbox and click
>>. The window is expanded as
shown in the figure.

Note

This step is optional. For more in-
formation about configuring distribu-
tion rules, see Distribution rules on
page 90.

2
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DescriptionActionStep

Click Save.3
The files are saved in the corres-
ponding system folders for each ro-
bot.

Mirror modules
You canmirror amodule between two virtual robots from the Programming Browser
tree.
To mirror a module:

DescriptionActionStep

In the Programming browser tree
select the module for which you
need to create a mirror.

1

xx1600001483

Right click on the selected module.
The context menu is displayed.

2

Select Mirror Module > <system
name>.

3

The mirror module is created in the
system you selected.
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4.6.3 Manage connections

Map a virtual and real robot
To load paint programs from the robots on the shop floor into RobotStudio, there
must be a mapping defined between the virtual robot in the RobotStudio station
and the real robot on the shop floor.
The following steps describe the mapping procedure:

Description/ImageActionStep

xx1600001480

In theSettings group, selectConfig-
ure > Map to Online Controller.
The Map to Online Controller win-
dow is displayed.

1

Note

Ensure that the PC is on the same network
as the robot controller and the PC-Interface
option is selected on the robot controller.

Select the virtual robot.2

Select the real robot from theName
list.

3

The IP Address of the selected real
robot is automatically loaded in the
IP Address field.

You can specify the username and
password configured in the real
controller for connecting to the ro-
bot, else the default credential is
used.

Note

To configure the default credentials
navigate to the File > Options >
Painting > Connection > Default
Credentials section.

4

Click Apply.5
The selected virtual robot ismapped
to the selected real robot.
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Connect and disconnect
To make a connection between a virtual robot and real robot:

Description/ImageActionStep

xx1600001481

Right-click on the selected robot
from the programming tree. The
context menu is displayed.

1

Select the Connect to <real robot
name> option.

2

The mapped robot is connected to
the real robot. Once connected the
icon near the virtual robot is up-
dated.

To disconnect the connection between a virtual robot and real robot:

Description/ImageActionStep

In the Programming browser tree
select the virtual robot for which you
need to disconnect .

1

xx1600001482

Right-click on the connected virtual
robot.
The context menu is displayed.

2
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Description/ImageActionStep

Select the Disconnect option.3
The virtual robot is disconnected
from the real robot.
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4.6.4 Distribution rules

Distribution rules

Overview
A painting booth usually contains several robots. Because of the axis-symmetrical
design of the workpiece, identical or mirrored (with movement programs) programs
normally exist on several robots. The changes can be either copied or mirrored
depending on the robot and the file type. Program modules, Brush Tables, and
Alias file types are supported. This is configured as distributionrules.xml
using which it is possible to make changes in a robot and automatically distribute
the changes to other robots.

Rules configuration
The following are the two types of rules defined in the distributionrules.xml
file:

• Copy
• Mirror

The rules can be configured for Program files, Brush Tables, and Alias files. For
program files, both copy and mirror can be configured and for brush file and alias
file only copy can be configured.
A sample configuration is shown below:

<?xml version="1.0"?>

<DistributionRules>

<Rule Name="Cell1_BrushFiles">

<Scope>BrushFiles</Scope>

<CopyAction>

<PartOf>{22c6a77e-2bec-4735-be36-823ad687d1f7}</PartOf>

<PartOf>{7437588d-f68e-4064-b46f-301c4e914832}</PartOf>

</CopyAction>

</Rule>

<Rule Name="Cell1_ProgramFiles">

<Scope>ProgramFiles</Scope>

<MirrorAction>

<PartOf>{22c6a77e-2bec-4735-be36-823ad687d1f7}</PartOf>

<PartOf>{73cd28c7-0aee-45b8-ba72-f057fb662a61}</PartOf>

</MirrorAction>

</Rule>

<Rule Name="Cell1_AliasFiles">

<Scope>AliasFiles</Scope>

<CopyAction>

<PartOf>{22c6a77e-2bec-4735-be36-823ad687d1f7}</PartOf>

<PartOf>{7437588d-f68e-4064-b46f-301c4e914832}</PartOf>

</CopyAction>

</Rule>

<Rule Name="Cell1_IndexFiles">

<Scope>IndexFiles</Scope>

<CopyAction>

<PartOf>{22c6a77e-2bec-4735-be36-823ad687d1f7}</PartOf>
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<PartOf>{7437588d-f68e-4064-b46f-301c4e914832}</PartOf>

</CopyAction>

</Rule>

</DistributionRules>

The following table provides a description of the elements available in the
distribution rules file.

DescriptionElement

Defines the name of the rule.Rule Name

Defines the rules for each type of file (brush tables, modules,
mapping files, index files).

Scope

Defines the type of action. Action can be copy or mirror.Action

Defines the copy andmirror relation between two virtual robots.
These robots are identified by their unique IDs.

PartOf

Use the following procedure to configure the distribution rules.

DescriptionActionStep

xx1700001819

Click Distribution Rule
from theSettings group on
the Painting ribbon tab.
The Distribution Rule
window is displayed.

1

Each tab display the controller present in the station
except itself. The distribution rule options for each con-
troller is displayed inside each tab.

Click on a tab to select a
controller for which the
rules need to be con-
figured.

2
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DescriptionActionStep

xx1700001820

Choose the destination
controllers and select the
rules to be configured.
The rules are instantan-
eously configured on the
selected controllers.

Note

Click Reset to change the
rules to the previous state.

3

Following are the rules configured in this example:
• W4A4_R11 -> W4A4_R12(Copy)
• W4A4_R11 -> W4A4_R21(Mirror)

xx1700001908

The rules are propagated
to other controllers as illus-
trated in the following im-
age.

xx1700001909

4

Note

The icon near a rule indicates that rules are applied
indirectly.
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4.6.5 Transfer programs

Transfer
The transfer feature allows you to transfer the files from the virtual robot to the
connected real robot.
To transfer the files:

DescriptionActionStep

xx1500002163

Click Transfer in the Program
group.
The Transfer window is displayed.
The changed module files, brush
table, index files, and alias files for
all the robots are listed in this win-
dow for transfer.

1

The Change Type column displays the type
of file change. DELETE denotes a deleted
file, EDIT denotes a changed file, and NEW
denotes a new file.
The Compare button allows you to compare
the changes in a file.

Select the files to be transferred.2

Change logs
Painting PowerPac allows you to type in
comments in a log file for the files that are
transferred from a PC to the robots on the
paint shop floor. Information like, file name,
user name and timestamp are recorded by
default. These information can be used for
further reference.

Write a brief description regarding
the transfer in the Comments sec-
tion.

3

Click the Transfer button.4
The selected files are transferred.
The files are transferred to the con-
nected real robot.
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4.7 Login and access control

4.7.1 Overview

User authentication system
TheUser Configuration feature is used tomanage the users and groups. To access
User Configuration, in the Settings group, click Configure and then click Users
and Groups. The User Configuration window is displayed.

xx1500002468
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4.7.2 Create user

Creating a user
To create a user:

DescriptionActionStep

Click Users drop down1
The List of Users window is dis-
played. It displays all the current
users.

xx1500002467

Click New User.
TheNewUserwindow is displayed.

2

Type a name for the user in the
User Name field.

3

Type a password in the Password
field.

4

Retype the password in theConfirm
Password field.

5

Click Create User.6
The new user is created.
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4.7.3 Create group

Creating a group
To create a group:

DescriptionActionStep

Click Groups drop down.1
The List of Groups window is dis-
played. It displays all the current
groups.

xx1500002466

Click New Group.
The New Group window is dis-
played.

2

Type a name for the group in the
Group Name field.

3

Type a description for the group in
the Description field.

4

Note

You can add or remove users from a group
using the Edit Users feature. For more de-
tails, see .

The Select Users section displays
all the available users. Select the
users that need to be assigned to
the new group from this list.

5

Click Create Group.6
The new group is created.
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4.7.4 Assign rights

Assigning rights to a user group
Once you create a group you can assign rights to the group:
To assign rights to a group:

DescriptionActionStep

Click the Groups drop down and
click on the group for which you
need to assign the rights.

1

The group details for the selected
group is displayed.

xx1500002464

Click the Features tab.
The features of Robotstudio are
displayed on various tabs according
to the category of the features.

2

Select the options required for the
selected group in various tabs ac-
cording to the requirement.

3

Click Save Changes.4
The changes to the selected group
are saved.
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4.7.5 Manage users

Managing users
You can add or remove users in a group:
To manage users in a group:

DescriptionActionStep

Click Groups drop down and click
on the group that you want to edit.

1

The Group details for the selected
group is displayed.

xx1500002465

Click Edit Users.
The Choose Users for Group win-
dow is displayed.

2

Add or remove users according to
your requirement.

3

Click OK.4

Click Save Changes.5
The changes to the selected group
are saved.
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4.7.6 Enable user authentication

Enabling user authentication
To enable user authentication:

DescriptionActionStep

xx1500002469

Click Options.
The options window is displayed.

1

Select Yes in the Enable User Au-
thentication field.

2

Click Save Changes.3
The user authentication is enabled.
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